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About this guide 

This document describes features and defect fixes introduced in Infor VISUAL 9.0.1.  

For information about features introduced in earlier versions of VISUAL, consult the release notes for 
that version. For example, if you are upgrading from VISUAL 7.1.2 to VISUAL 9.0.1, consult the 
release notes for VISUAL 8.0.0 and VISUAL 9.0.0 for important information about the features 
introduced in those releases.  

You can find release notes on Infor Xtreme. 

Intended audience 
This document is intended for any VISUAL user. 

Related documents 
You can find the documents in the product documentation section of the Infor Xtreme Support portal, 
as described in "Contacting Infor" on page 5. 

Infor VISUAL 9.0.1 Hardware Guidelines 

Infor VISUAL 9.0.1 Software Compatibility 

Infor VISUAL 9.0.1 Applications Installation Guide 

Infor VISUAL 9.0.1 Database Installation Guide for Oracle 

Infor VISUAL 9.0.1 Database Installation Guide for SQL Server 

Contacting Infor 
If you have questions about Infor products, go to the Infor Xtreme Support portal. 
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If we update this document after the product release, we will post the new version on this Web site. 
We recommend that you check this Web site periodically for updated documentation.  

If you have comments about Infor documentation, contact documentation@infor.com. 

 

mailto:documentation@infor.com
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Chapter 1 Prerequisites 1  
 

 

This section lists the software required to use Infor VISUAL as of the publication date of this 
document. For up-to-date information, see the Infor VISUAL 9.0.1 Compatibility Matrix.  

This software is required to use Infor VISUAL 9.0.1: 

Database engine. You must use one of these database engines: 

• SQLServer 2008 R2 
• SQLServer 2012 and 2012 R2 
• SQLServer 2014 
• SQLServer 2016 
• Oracle 11g 
• Oracle 12c 

Server operating system. You must use one of these server operating systems: 

• Windows 2008 32-bit with Oracle 11g or SQL Server 2008 R2. Windows 2008 64-bit with Oracle 
11g, Oracle 12c, or SQL Server 2008 R2. 

• Windows 2008 R2 64-bit with any of the above database engines 
• Windows 2012 and 2012 R2 with any of the above database engines 

Client operating system. Your clients must use one of these operating systems: 

• Windows 7 SP1 
• Windows 8 
• Windows 8.1 
• Windows 10 

Gupta runtime requirements 
VISUAL 9.0.1 requires the use of the Gupta 7.0 Update 1 runtime. Previous versions of the Gupta 
runtime are not compatible with VISUAL 9.0.1.  

Infor strongly recommends removing all previous versions of the Gupta runtime before installing 
VISUAL 9.0.1. 
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Infor strongly recommends that you do not use multiple versions of the Gupta runtimes on the same 
client.
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Chapter 2 Enhancements 2  
 

 

This release introduces enhancements and improvements in a variety of areas in VISUAL, including 
several enhancements submitted in the Infor Xtreme Enhancement Request System. 

Checking customer credit limit at shipment (ERS 
8770) 
In Shipping Entry or BTS Shipping Entry, you can optionally check the customer’s credit limit again 
before you ship the order. You can prevent the shipment of the order if the customer has exceeded 
the credit limit. 

To set up this feature, use the new Ship Credit Limit Control field located on the Entity Credit Limit 
tab in Customer Maintenance. You can select one of these options: 

No Credit Evaluation 

Select this option if you do not want to check the customer’s credit status at the time of shipment. 

Override Allowed 

Select this option to allow users to ship orders for customers who have exceeded their credit limit. A 
message is displayed to warn users that the credit limit has been exceeded, but users can still save 
orders. 

No Override 

Select this option to prevent users from shipping orders to customers who have exceeded their 
credit limit. A message is displayed informing users that the customer has exceeded the credit limit. 
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Return by exception in Inventory Transaction Entry 
(ERS 5367) 
The Issue by Exception menu item in Inventory Transaction Entry has been renamed to Issue and 
Return by Exception. You can now automatically return all materials issued to a work order instead 
of entering transactions one-by-one in the Inventory Transaction Entry window. 

You can use the table in the Work Order Material Issues dialog to specify the quantities to return, or 
you can use Auto Return mode. When you use Auto Return mode, you can manually select the 
warehouse locations to use in the inventory transactions, or you can automatically return materials to 
the warehouse locations from which they were issued. 

Create date and modified date for part and part site 
records (ERS 7470) 
You can now view the date that the tenant-level and site-level part records were created and date of 
the most recent modification. 

When you upgrade your database, the date that you upgraded your database is inserted in the 
Create Date field for all existing tenant-level and site-level part records. The Modified Date field is 
blank. For an existing part, the modified date is updated when you make a change to the record.  

You can add these fields to the Part View Panel.  

URL fields (ERS 13986) 
The length for URL fields has been increased to 256 characters. 

Deletion of engineering masters (ERS 13965) 
If you attempt to delete an engineering master that is the default master for a part, a message is 
displayed to notify you. You can continue or cancel the deletion. 
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Examine Indexes feature 
Use the new Examine Indexes feature to compare the indexes in your database with a master list. 
Missing indexes, custom indexes, and incorrect indexes are identified. You can use the Repair 
function to fix incorrect indexes and add missing indexes to your database. 

Video library 
You can access the VISUAL video library directly from VISUAL. From the main VISUAL executable, 
select Help > Video Library. A list of videos that demonstrate new features in VISUAL is displayed. 
Double-click the name of a video to view it in your computer’s video viewer. The videos are in MP4 
format. 

You can also open the video viewer directly. In the directory that contains your VISUAL executables, 
locate VMVIDEO.exe. Open the executable to view the videos.  

Note: a video viewer is not provided with VISUAL. 

User defined field labels in Contact Maintenance 
You can now define label sets for user-defined fields directly in Contact Maintenance. Select 
Maintain > User-defined Field Labels to set up the label sets.  

Query Tool updates 
The Query Tool has been updated to include these features: 

Interactive queries. You can prompt users to specify the variables to use to complete a WHERE 
clause when they run a query. The prompt is an interactive dialog where users specify the variables 
to use. When you write the query, you can specify the field labels to use in the dialog and whether 
wildcards are allowed.  

To prompt users for WHERE variables, use a colon (:) in your WHERE clause.  

Use this syntax to allow users to specify wildcards: 

WHERE table.column like :“Dialog Field Name” 

Use this syntax to require users to specify an exact value: 

WHERE table.column =:”Dialog Field Name” 

Use this syntax to allow users to specify a range of values: 
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WHERE table.column > :”Beginning of Range Field Name” and table.column < :”End of Range Field 
Name” 

For example, presume you specify this WHERE clause in your query: 

WHERE CUSTOMER.ID like:”My Customer ID” 

When a user runs your query, a dialog with one field is displayed. The field is labeled My Customer 
ID. The user can specify wildcards in the field.  

You can include more than one column in your WHERE clause.  

Column Aliases. You can now specify a column alias to use in place of the database column name 
in query results. You can use column aliases to more clearly label the content of the column. For 
example, presume you specify this query statement: 

SELECT ID, IND_CODE “Industrial Code” FROM CUSTOMER 

When the query is executed, ID is used as the column label for customer ID. Industrial Code is used 
as the column label for IND_CODE. 

Table Aliases. You can now specify a table alias to use in place of a table name in your query.  

Drill-to Buttons. Drill-to buttons have been added to the query results table. You can click the 
button to open the related record. 

Inactive product codes 
You can use the new Active check box to make a product code inactive. When a product code is 
inactive, it cannot be used in any new part records.  

Drill-to buttons in the Manufacturing Window and 
Project Window 
Drill-to buttons have been added to Material and Operation cards in the Manufacturing window. They 
have also been added to the Task and Leg/Detail cards in the Project window.  
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Chapter 3 Quick Upgrade 3  
 

Who can use this procedure? 
To use this procedure, you must currently use VISUAL 9.0.0. If you use any other version of VISUAL 
or if you are installing VISUAL for the first time, you must follow the procedures in the installation 
guide to install VISUAL 9.0.1. 

See Infor VISUAL Applications Installation Guide. 

Upgrading from VISUAL 9.0.0 to VISUAL 9.0.1 
This table shows how to upgrade VISUAL 9.0.0 to VISUAL 9.0.1: 

Sequence Step Notes 

1 Verify that the 
database client 
components are 
installed. 

See your SQL Server or Oracle user 
documentation 

2 Back up your 
existing database 

See the documentation for your database engine. 

3 If you use an 
application server, 
update VISUAL on 
the server 

When prompted by the installation wizard, select 
Infor VISUAL Application Server Set Up. 
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Sequence Step Notes 

4 Update VISUAL on 
clients 

When prompted by the installation wizard, select 
one of these options: 
If you have installed all VISUAL executables on 
the client, select When prompted by the 
installation wizard, select Infor VISUAL 
Application Server Set Up.  
If you have installed only the manufacturing 
applications on the client, select Infor VISUAL 
Manufacturing Applications Only Set Up. 
If you have installed only the financial 
applications, select Infor VISUAL Financial 
Application Only Set Up. 
If you have installed a thin client, select Infor 
VISUAL Client Only Set Up. 

5 Sign into VISUAL to 
upgrade the 
database.  

 

For more detailed instructions, see Infor VISUAL Applications Installation Guide. 
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Chapter 4 Program updates 4  
 

 

This table lists the changes made to VISUAL programs from the VISUAL 9.0.0 GA release. The 
table lists the additional enhancements sorted by application name and then the improvements 
sorted by application name. 

Table entries with an application name of “VISUAL API Toolkit” represent a group of files that must 
be updated together to work properly. See Appendix A VISUAL API Toolkit file listing. 
* Indicates that the file is included in a client install.  

Application Name File Name Defect Description 

A/P Payment 
Scheduling 

VFAPSCHD 596041 ENHANCEMENT 
A new preference setting is available that you can 
use to pay vouchers that have a status of receiving 
inspection. Set the preference to "Y" to enable this 
preference. Set preference to "N" to disallow 
payment of vouchers in receiving inspection. 

API Toolkit API Toolkit 593917 ENHANCEMENT 
A new Receiving Inspection object has been added 
to the API Toolkit. 

API Toolkit API Toolkit 593317 ENHANCEMENT 
API Toolkit auto-numbered IDs are now returned to 
the caller after a save. 

Preferences PREFERENC
ES.SQL 

596041 ENHANCEMENT 
A new preference setting is available that you can 
use to pay vouchers that have a status of receiving 
inspection. Set the preference to "Y" to enable this 
preference. Set preference to "N" to disallow 
payment of vouchers in receiving inspection. 

A/P Invoice Entry VFAPIENT 543695 Fixed issue to clear the Vendor ID and to correctly 
display the Currency ID and Currency Name when 
the site is changed.  

A/P Invoice Entry VFAPIENT 598962 Fixed issue to correctly format the Qty column when 
using Italian in regional settings. 
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Application Name File Name Defect Description 

A/P Invoice Entry VFAPIENT 501576 Fixed issue to update inventory when a voucher in 
entity currency is assigned to a purchase order in a 
non-tracking currency. 

A/P Invoice Entry VFAPIENT 526507 Fixed unrecoverable error issue using prepayments 
for multiple receivers. 

A/R Collections VFARCLCT 502788 Fixed issue to correctly display the Over/Under 
amount in the Customer History report. 

Activity Maintenance VMACTMNT 565028 Fixed issue by enabling the Activities menu option 
from the View menu when the user adds new 
activities with a Part ID. 

API Toolkit API Toolkit 603545 Fixed API Toolkit  issue with creating contacts for 
existing customers. 

API Toolkit API Toolkit 594342 Fixed API Toolkit issue to correctly auto-backflush 
labor and materials on shipments. 

API Toolkit API Toolkit 590700 Fixed API Toolkit issue to correctly generate auto-
issue transactions for labor tickets. 

API Toolkit API Toolkit 592316 Fixed API Toolkit issue to correctly process receipts 
on non-system currency purchase orders. 

API Toolkit API Toolkit 593826 Fixed API Toolkit issue to correctly process the 
purchase orders of non-system currencies. 

API Toolkit API Toolkit 592178 Fixed API Toolkit issue to correctly set the purchase 
order to closed when fully received. 

API Toolkit API Toolkit 595180 Fixed API Toolkit issue to permit the receipt of parts 
for inspection into locations where they are on 
HOLD. 

API Toolkit API Toolkit 591246 Fixed API Toolkit issue to populate the correct 
Purchase Order Unit Price on the Receiver line. 

API Toolkit API Toolkit 592197 Fixed API Toolkit issue to prevent generating a 
shipment for a closed period. 

API Toolkit API Toolkit 603377 Fixed API Toolkit issue to use the correct date when 
receiver currency is converted. 

API Toolkit API Toolkit 594945 Fixed API Toolkit issue with saving customer orders 
when a new work order is created on an order line. 

API Toolkit API Toolkit 592217 Fixed API Toolkit issue with the shipment logic to 
honor selection of the negative inventory shipment 
option. 
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Application Name File Name Defect Description 

API Toolkit API Toolkit 597984 Fixed issue with the API Toolkit receiving assembly 
not handling trace quantities correctly. 

API Toolkit API Toolkit 598678 Fixed issue with the API Toolkit removing the 
primary contact when updating a customer record. 

API Toolkit API Toolkit 600296 Fixed issue with the API Toolkit to correctly process 
the Inspection Quantity within the Inspection 
Receiving object. 

API Toolkit API Toolkit 598869 Fixed issue with the API Toolkit to now correctly 
process adding a line to an existing quote. 

Barcode Transaction 
System 

VMBTS.EXE 597783 Fixed issue to correctly process a part that requires 
inspection when the UsePartIDforPO preference is 
enabled in the VMBTS.INI file. 

Barcode Transaction 
System 

VMBTS.EXE 529746 Fixed issue where a purchase order linked to a 
work order could not be received when the 
purchased part did not have an assigned primary 
warehouse. 

Barcode Transaction 
System 

VMBTS.EXE 407060 Fixed issue where an invalid Trace ID was accepted 
when issuing or returning a trace part. 

Contact Maintenance VMCONMNT 443756 Fixed issue with being unable to define default user-
defined label set. 

Contact Maintenance VMCONMNT 583074 Fixed issue with the Quick Filter by Contact ID in 
Contact Maintenance to return the correct filter 
results. 

Costing Tools VMAPLTLS 595861 Fixed issue to correctly cost shipments for sites 
when an internal order is processed and the sites' 
parent entities use different functional currencies. 

Costing Tools VMAPLTLS 569637 Fixed issue to properly clear previous transaction 
exchange rates when recalculating inventory 
balances. 

Costing Tools VMAPLTLS 606149 Fixed issue with receiving an Oracle error message 
when preparing Shipment journals.  

Costing Utilities VMAPLUTL 595861 Fixed issue to correctly cost shipments for sites 
when an internal order is processed and the sites' 
parent entities use different functional currencies. 

Costing Utilities VMAPLUTL 606149 Fixed issue with receiving an Oracle error message 
when preparing Shipment journals.  

Costing Utilities VMAPLUTL 526173 Fixed issue to correctly display the voided AP 
invoice in the Project Summary window.  
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Application Name File Name Defect Description 

Costing Utilities VMAPLUTL 526173 Fixed issue to correctly display the voided AP 
invoice in the Project Summary window. 

Costing Utilities VMAPLUTL 478321 Fixed issue to correctly update the inventory 
balance table based on the work order receipt for a 
work order that is returned and cancelled in the 
current period. 

Costing Utilities VMAPLUTL 569637 Fixed issue to properly clear previous transaction 
exchange rates when recalculating inventory 
balances. 

CRM Fix Distribution 
Utility 

VCRMINV 594230 Fixed issue where VISUAL CRM was incorrectly 
displaying the receivable buy/sell rate. 

Customer 
Maintenance 

VMCUSMNT 604258 Fixed issue to allow all users to access to the Site 
field and Email Invoices check box on the Ord Mgt 
tab.  

Customer Order Entry VMORDENT 596569 Fixed issue to allow users to modify contact 
information on an internal customer order.  

Customer Order Entry VMORDENT 599160 Fixed issue to display a message when the quoted 
unit price contains more than nine digits. 

Customer Order Entry VMORDENT 593349 Fixed issue to update the unit price based on the 
customer pricing. 

Customer Order Entry VMORDENT 598476 Fixed issue where the user interface between 
applications was inconsistent regarding 
specifications and notations. 

Customer Order Entry VMORDENT 599933 Fixed issue with window not displaying properly 
when maximizing, closing, and then reopening the 
window. 

Employee 
Maintenance 

VMEMPMNT 594227 Fixed issue to prevent the deletion of an employee 
assigned to a project. 

Estimating Window VMESTWIN 599160 Fixed issue to display a message when the quoted 
unit price contains more than nine digits. 

Financials Application 
Global 

VFAPLGLB 596767 Fixed issue by insuring that the Allow multiple AP 
invoices per receiver line check box is cleared for 
entities with standard costing enabled. 

Financials Online 
Help* 

VF.CHM 596041 Updated with information about the payment 
scheduling preference that allows the payment of 
vouchers in receiving inspection. 

General Journal Entry VFGLTENT 602378 Fixed issue to allow sorting in the Account browse 
table. 



Program updates 

Infor VISUAL 9.0.1 Release Notes  | 23 

Application Name File Name Defect Description 

General Journal Entry VFGLTENT 597142 Fixed issue to honor the modified values specified 
for exchange rates when saving a general ledger 
entry. 

General Journal Entry VFGLTENT 569067 Fixed issue to post a transposed batch from the 
Batch Information window to the general ledger. 

IBT Packlist (Print 
Form) 

VMIBSFM1.Q
RP 

 Fixed issue with report breaking by From 
Warehouse ID instead of Packlist ID and updated 
the display of Packlist ID to the correct variable 

Infor VISUAL API 
Toolkit Core Class 
Library Reference* 

VISUALTOO
LKITCORER
EFERENCE.
PDF 

 Added information about the OpenLocal(String, 
String, String, String, String), OpenLocalSSO 
(String, String, String, String, String) and 
OpenLocalSSO (String, String, String, String, 
String, String) methods. 

Infor VISUAL API 
Toolkit Development 
Guide* 

VISUALTOO
LKITDEVELO
PMENTGUID
E.PDF 

593317 Added information about auto-numbering.  

Infor VISUAL API 
Toolkit Inventory 
Class Library 
Reference* 

VISUALTOO
LKITVMFGIN
VENTORY.P
DF 

 Added information about transaction_ID. 

Infor VISUAL API 
Toolkit Purchasing 
Class Library 
Reference* 

VISUALTOO
LKITVMFGP
URCHASING
.PDF 

 Added information about the ReceivingInspection 
object. 

Infor VISUAL API 
Toolkit Sales Class 
Library Reference* 

VISUALTOO
LKITVMFGS
ALESREFER
ENCE.PDF 

594945 Added information about generating a new work 
order from a customer order line.  

Infor VISUAL API 
Toolkit Sales Class 
Library Reference* 

VISUALTOO
LKITVMFGS
ALESREFER
ENCE.PDF 

 Added information about shipments being saved 
individually.  

Infor VISUAL 
Financials Account 
Payables User Guide* 

VISUALPAYA
BLES.PDF 

596041 Updated with information about the payment 
scheduling preference that allows the payment of 
vouchers in receiving inspection. 

Infor VISUAL Oracle 
11g Database 
Installation Guide* 

INFORVISUA
LORACLEIN
STALL11G.P
DF 

 Updated description of SQL.ini file settings to 
remove TNS from the remote database name. 
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Application Name File Name Defect Description 

Infor VISUAL Oracle 
12C Database 
Installation Guide* 

INFORVISUA
LORACLEIN
STALL12C.P
DF 

 Updated description of SQL.ini file settings to 
remove TNS from the remote database name. 

Inventory Transaction 
Entry 

VMINVENT 582364 Fixed issue of labor costs not being backflushed 
correctly for work orders with co-products. 

Inventory Transaction 
Entry 

VMINVENT 596596 Fixed issue to display 30 character thermal label 
Trace IDs in the search area. Previously, only 15 
characters were displayed. 

Inventory Transation 
Entry 

VMINVENT 604658 Fixed issue to properly create labor tickets when 
receiving multiple work orders with co-products and 
auto-reported operations. 

Inventory Transation 
Entry 

VMINVENT 601684 Fixed issue to save part trace information with 
inventory transactions when processing multiple 
work orders. 

Inventory Transation 
Entry 

VMINVENT 602970 Fixed issue to update the average cost when 
issuing by exception when prompted for the 
warehouse location. 

Invoice Forms VMINVGEN 597675 Fixed issue where credit report totals only displayed 
the last line of the memo when the computer's 
regional settings were not set to English. 

Manufacturing Main 
Menu 

VM 605108 Fixed issue to allow users to add more than 99 
users. 

Manufacturing 
Window 

VMMFGWIN 597806 Fixed issue to correctly calculate quantity when the 
Dimension is zero. 

Material Planning 
Window 

VMPLNWIN 591917 Fixed "Unable to add value to child table" error 
issue when the All Exceptions option is selected in 
the Advanced Material Planning Window. 

Material Planning 
Window 

VMPLNWIN 594354 Fixed issue to display the correct Qty On Hand 
value in the MPS window for independently planned 
warehouses. 

Order Management 
Window 

VMORDWIN 596569 Fixed issue to allow users to modify contact 
information on an internal customer order.  

Order Management 
Window 

VMORDWIN 599160 Fixed issue to display a message when the quoted 
unit price contains more than nine digits. 

Order Management 
Window 

VMORDWIN 593487 Fixed issue to display VAT related columns for VAT 
enabled sites. 
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Application Name File Name Defect Description 

Order Management 
Window 

VMORDWIN 433478 Fixed issue to retain the display of customer orders 
in the history window after opening and closing a 
customer order. 

Order Management 
Window 

VMORDWIN 593349 Fixed issue to update the unit price based on the 
customer pricing. 

Order Management 
Window 

VMORDWIN 599591 Fixed SQL error issue when deleting a customer 
order line. 

Order Management 
Window 

VMORDWIN 596569 Fixed issue to allow users to modify contact 
information on an internal customer order.  

Order Management 
Window 

VMORDWIN 598476 Fixed issue where the user interface between 
applications was inconsistent regarding 
specifications and notations. 

Order Management 
Window 

VMORDWIN 599933 Fixed issue with window not displaying properly 
when maximizing, closing, and then reopening the 
window. 

Outside Service 
Planning Window 

VMSRVPLN 599197 Fixed issue to use the correct unit price of a 
returned shipment for returned order lines from 
different packlists. 

Part Maintenance VMPRTMNT 565028 Fixed issue by enabling the Activities menu option 
from the View menu when the user adds new 
activities with a Part ID. 

Physical Inventory 
Count 

VMPHYINV 597042 Fixed issue where auto browsing by Part ID now 
works properly. 

Physical Inventory 
Count 

VMPHYINV 604369 Fixed issue with the Email Browser being launched 
when printing the Tag Comparison Report. 

Preferences PREFERENC
ES.SQL 

 A NoMPCPriceConversion entry has been added to 
the MPC section. Specify Y if you do not want to 
convert the MPC price to the order entry price using 
the exchange rate. Specify N if you do want to 
convert the MPC price. 

Project Revenue 
Recognition 

VMREVREC 595166 Fixed issue where shipped, uninvoiced transactions 
were prepared incorrectly. 

Project Summary 
Window 

VMPRJSUM 582163 Fixed issue to correctly display the new ETC rates. 

Project Summary 
Window 

VMPRJSUM 582168 Fixed issue to prevent ETC values from being 
cleared when updating ETCs with Actuals. 
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Application Name File Name Defect Description 

Project Summary 
Window 

VMPRJSUM 585621 Fixed SQL error issue when clicking the Total 
Amounts column header in the Project Summary 
dialog table. 

Purchase 
Management Window 

VMPURWIN 585942 Fixed issue to allow editing of the purchase order 
quantity after the delivery schedule is cleared. 

Purchase 
Management Window 

VMPURWIN 583271 Fixed issue to correctly populate the vendor contact 
e-mail and contact mobile number when generating 
a Purchase Order from Purchase Requisition. 

Purchase 
Management Window 

VMPURWIN 596596 Fixed issue to display 30 character thermal label 
Trace IDs in the search area. Previously, only 15 
characters were displayed. 

Purchase 
Management Window 

VMPURWIN 599160 Fixed issue to display a message when the quoted 
unit price contains more than nine digits. 

Purchase 
Management Window 

VMPURWIN 457605 Fixed issue to prevent duplication in certain 
circumstances of a purchase order line generated 
during requisition. 

Purchase 
Management Window 

VMPURWIN 592052 Fixed issue to prevent incorrectly displaying the Site 
does not Exist" message 

Purchase 
Management Window 

VMPURWIN 592052 Fixed issue to prevent incorrectly displaying the Site 
does not Exist" message. 

Purchase 
Management Window 

VMPURWIN 577528 Fixed issue to use the specified Dispatch Service 
Address ID in the Dispatch Packlist dialog including 
when it is modified in the Outside Service Dispatch 
Entry window. 

Purchase Order Entry VMPURENT 585942 Fixed issue to allow editing of the purchase order 
quantity after the delivery schedule is cleared. 

Purchase Order Entry VMPURENT 583271 Fixed issue to correctly populate the vendor contact 
e-mail and contact mobile number when generating 
a Purchase Order from Purchase Requisition. 

Purchase Order Entry VMPURENT 596596 Fixed issue to display 30 character thermal label 
Trace IDs in the search area. Previously, only 15 
characters were displayed. 

Purchase Order Entry VMPURENT 599160 Fixed issue to display a message when the quoted 
unit price contains more than nine digits. 

Purchase Order Entry VMPURENT 457605 Fixed issue to prevent duplication in certain 
circumstances of a purchase order line generated 
during requisition. 
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Application Name File Name Defect Description 

Purchase Order Entry VMPURENT 577528 Fixed issue to use the specified Dispatch Service 
Address ID in the Dispatch Packlist dialog including 
when it is modified in the Outside Service Dispatch 
Entry window. 

Query Run VMQRYRUN 605108 Fixed issue to increase the number of rows that can 
be displayed in the table. 

Query Tool VMQUERY 605108 Fixed issue to increase the number of rows that can 
be displayed in the table. 

Receiving VMRCVENT 596313 Fixed issue to display only locations of the selected 
warehouse in the Purchase Receipt Entry window. 

Receiving VMRCVENT 599912 Fixed issue with receiving an error message when 
making a return to a warehouse location that has 
the same name as a consignment location in a 
different warehouse. 

Shipping Entry VMSHPENT 472513 Fixed 104 error issue when reprinting a shipment 
packlist from an Oracle database. 

Shipping Entry VMSHPENT 561476 Fixed issue to correctly honor the Issue Negative 
settings when changing the location of a shipper 
line with a delivery schedule.  

Shipping Entry VMSHPENT 561476 Fixed issue to correctly honor the Issue Negative 
settings when changing the location of a shipper 
line with a delivery schedule.  

Shipping Entry VMSHPENT 597199 Fixed issue to use the correct unit price of a 
returned shipment for returned order lines from 
different packlists. 

Shipping Entry VMSHPENT 547847 Fixed issue where there was no selection to print 
when printing a packlist before shipment and no 
delivery schedule lines existed 

VM/CRM Sync Utility VMCRMSNC 593123
3 

Fixed issue to update the Modified Date for 
resynchronized contact associations of contacts 
both in VISUAL and VISUAL CRM. 

Work Order Traveller VMTRVRPT 542406 Fixed issue to process and print a traveller and 
attached picklist in the correct sequence 
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Appendix A API Toolkit contents A  
 

 

The VISUAL API Toolkit is a group of files that must be updated together to work properly.  

The toolkit is composed of these files: 

• Dynamic link libraries: 

ORACLE.MANAGEDDATAACCESS.DLL 
ORACLE.MANAGEDDATAACCESSDTC.DLL 
LSACORE.DLL 
LSASHARED.DLL 
VMFGFINANCIALS.DLL 
VMFGINVENTORY.DLL 
VMFGPURCHASING.DLL 
VMFGSALES.DLL 
VMFGSHARED.DLL 
VMFGSHOPFLOOR.DLL 
VMFGTRACE.DLL 

• Executable: 

VMFGCONFIGFORMS.EXE 

• Configuration: 

VMFGCONFIGFORMS.EXE.CONFIG 

• Samples: 

VMFGSAMPLESAPITOOLKIT.ZIP 
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